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Entity Relationship Diagram
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[

FIELD NAME DATA SIZE DESCRIPTION KEY TABLE
TYPE
m_id INT 1| siadld PK
m_username VARCHAR | 20 % 3] :fhgfj
m_password VARCHAR | 20 | s¥dr1u
m_title VARCHAR | 10 | fmibwiinye
m_name VARCHAR 50 ‘?5 3}
m_surname VARCHAR | 50 /| #udna
m_nickname VARCHAR'| 30 | ¥owu
m_gender VARCHAR 5 INF
m_birthD VARCHAR | 2 | Sufiifia
m_birthM VARCHAR | 20 | ifiouiiiia
m_birthY VARCHAR | 4 | iliiifia
m_address VARCHAR | 150 *| fieg
ampr_code VARCHAR 4 SAAOUND FK ampr
m_zipcode VARCHAR 5 s¥rarlilswale
m_phonehome VARCHAR | 30" | 15 Inssnsithu
m_phonemobile VARCHAR | 30 | 1wesInsdnsiilede
m_email VARCHAR | 40 |dwd
m_school VARCHAR | 150 | Isai50u
m el id INT 11 | sWasgaumsane FK | education_level
m_interest TEXT ’s?{ Q‘ﬁﬁ uly
m_name_quardian VARCHAR | 50 glﬂ)' 0 l?jlﬂﬂﬂi 3N
m_surname_quardian | VARCHAR | 50 | #uana Fj:ﬂ NATDI
m_type_quardian VARCHAR | 50 |anuferdesdnases
m_office_quardian VARCHAR | 150 ﬁmuﬁﬁnmé’ﬂﬂmm
m_phone quardian VARCHAR | 30 |10 Ingin ﬁéj Unnseq
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m_email quardian

VARCHAR

30

=) oY
pruaarnAIng

A15199 3.56 A131952AUMSANET (education_level)

o a < { < @ a g
Mesue : Wuasei s lumanudeyaszaumsnm Usznoudieilanaie

A9l
FIELD NAME DATA | SIZE DESCRIPTION KEY TABLE
TYPE
el id INT 11 | sHasgaumsane PK
el name VARCHAR | 150 | ¥832aUmsAn

A15199 3.57 A1319%0A15 195 0U (table_title)

o A < A S 9 A ~ Y A J
AIDIUY L‘]J‘NGITiN‘ﬂGlGD'HGluﬂﬁ!ﬂﬂ“ll@yjﬁ%’@ﬂﬁNliﬂu ﬂﬁgﬂ’f)‘]Jﬂ’JEW‘Iﬁﬂ@]NG]

o d
At
FIELD NAME DATA | SIZE DESCRIPTION KEY TABLE
TYPE
¢ title id INT 11| saiveasalsou PK
t title el id INT 11| sHaseaumMsAnNYI FK table_student
A39R 3.58 M151991571903 01 (table student)
fotue : HumsilsDlunsfudeyemseon  dszneudaeiladae
Yol
FIELD NAME DATA | SIZE DESCRIPTION KEY TABLE
TYPE
t id INT 11 | saasniseu PK
t ¢ id INT 11 | sWaInisou FK course
t b id INT 11| sWaanicou FK branch
t cr id INT 11 sHaresisouFeu FK class_room
t time_start VARCHAR | 10 | nafizuizen
t time_finish VARCHAR | 10 | &u qmamﬁﬁﬂu
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VARCHAR 10 AUNLIYU

t date

t title id INT 11| sieivemsaisou FK table _title
msnﬁ 3.59 M3 199138U (course)

Mesune : uasei 19 lunsfudeyainideu Uszneudeilasman il
FIELD NAME DATA | SIZE DESCRIPTION KEY TABLE
TYPE

c id INT 11 | shaniseu PK

¢ name VARCHAR | 20 | ¥oiniden

¢_price VARCHAR | 10 | s1a133i5eu

d' A S A
M319N 3.60 G]ﬁNGIffJﬂiglﬂﬂﬂ’fJiﬁL‘iﬁm (type_course)
o A & A = ©) A I A Y
ALY gﬂuminﬂﬂsD°1umimmanva%aﬂizmmﬂaimiau ﬂ’i%ﬂ@ﬂﬂ’)&l

a LAl [ dy
Waan1eq aail

FIELD NAME DATA SIZE DESCRIPTION KEY TABLE
TYPE
tc_id INT 11| s/faiadeilssianaesaiFen | PK
tc_price VARCHAR'| 10 [ 517005 aiFeu
tc el id INT 11 SHATLAVMSANEN FK | education level

a J A
M3 3.61 15 19YTUNNADT ATIU (tc_course)
o A ] { ] s A & o
Mesuie : Huaswnlslumsinudeyaszmnaeiaisou Uszneuaieilan

A3 A1 &
FIELD DATA | SIZE DESCRIPTION KEY | TABLE
NAME TYPE
tec_id INT 11| svalszanaesaiseu PK
t id INT 11| sfaivedszannedaieu FK | type course
c id INT 11 SHAIVUTOU FK course
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(I

FIELD DATA | SIZE DESCRIPTION KEY | TABLE
NAME TYPE

cr id INT 11 | s¥aresiseu PK

cr_name VARCHAR | 50 | ¥orfoaidou

cr_branch INT 11 sHAaVITOU FK branch

M51N 3.63 AT NADIUNGEU (branch)

fetue - Aunianily lumsfudagaaniuidey Useneudeilasman
fail
FIELD NAME | DATA | SIZE DESCRIPTION KEY | TABLE
TYPE
b id INT 11| sHaevniseu PK
b_name VARCHAR | 20 | Foawfou

M39N 3.64 A1519MTAINT U (register)

fotue - HumseiilsDlunsfudeyeamadon  dszneudieiladae
Yol
FIELD NAME | DATA | SIZE DESCRIPTION KEY TABLE
TYPE
r id INT 11 | 5vid PK
r m_id INT 11 I :fl‘]gfj FK member
r el id INT 11 SHATLAUMSIANEN FK education_level
r te id INT 11| sita¥erszinnaesaitou FK type_course
rcid INT 11 SHaINIGoU FK course
r sh id INT 11 Iva L'Léflﬂ FK shirt_size
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r date_start DATE UNGUTeU
r_date finish DATE ?; uga wu‘ﬁld g
r_pay CHAR 2| g0umseRy
r_date DATE Fuiiaanzifou

&
M99 3.65 AT NUUIALAD (shirt_size)

oA < { < y a J -
Mesuie : Humsin s lumanudeyavuiaie diznoudroflasaie aail

[

FIELD NAME DATA SIZE DESCRIPTION KEY TABLE
TYPE

sh_id INT 11 | 5vid PK

sh_size VARCHAR | 20 [ 9Ua

sh_chk CHAR 2 ﬁﬂ”m%ﬂTii‘%ﬂ"%ﬂ

sh_el id INT 11 SHATEAUMSANE FK education_level

M519N 3.66 M13191AANT (personnel)

° a I P < 9 9 a Eal g
Mosuie : 1Wumsnily I lumsinuteyaynains Uszneudieiannise asll

[

FIELD NAME DATA SIZE DESCRIPTION KEY TABLE
TYPE
p id INT 1T | svd PK
p_title VARCHAR | 10| mimiinie
p_name VARCHAR 50 G?f 0
p_surname VARCHAR 50 | wwana
p_nickname VARCHAR 30 | voLau
p_gender VARCHAR 5 INe
p_birthD VARCHAR | 2 | fufiifia
p_birthM VARCHAR | 20 | @oufiiia
p_birthY VARCHAR | 4 |7iifa
p_address VARCHAR | 150 ‘ﬁﬂgi
ampr_code VARCHAR 4 A UND FK ampr
p_zipcode VARCHAR | 5 | 3¥a'lisuald
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p_phonehome VARCHAR 30 | wes InsAwnihu

p_phonemobile VARCHAR | 30 |1we$Insdnsiilede

p_email VARCHAR | 40 |3wd

p_school VARCHAR | 150 | Tsaioufiaeu

p_education level | VARCHAR | 150 | Sz@uUmM3IAnEN

p_teach INT 11 THAIY W‘ﬁ R)"! FK course
p_teach2 INT 11 SYiel aclﬂ‘ﬁﬁ U FK course
p_teach3 INT 11 SYe aclﬂ‘ﬁﬁ o FK course

d' ] v o
MI9N 3.67 M5 NUVNY T TUNUT (news)

o A <3| ! < ' v W a
mosuie - Wlumsteily D lumsnudeyaiimlszmnduius dsznoudieila

A9 A9 i

FIELD NAME | DATA TYPE | SIZE DESCRIPTION KEY | TABLE
new id INT SHAUN PK

new_title TEXT F40917

new_detail TEXT 519921DIAUT

new_type INT Usznnan

new file VARCHAR Idionans

new_date DATE Ui

new_time TIME naTfiN9

q' ] 1 9 %
MTNN 3.68 AT WUNAUMNIUIUDHA (news_person)

o A I A 3 9 ' "y o Y A J
A1DDIVY : Lﬂu@']ﬁ'l\iﬂclf']fmGluﬂ']ﬁlﬂﬂallau”a(’u'nﬂulﬂﬂﬂ'luaya'l sznovuaeilaa

A9 o
FIELD NAME | DATATYPE | SIZE DESCRIPTION KEY | TABLE
id photo INT 11 THAUN PK
name_photo VARCHAR 30 NN
detail_photo BLOB 51092109AU1)
title VARCHAR 150 fve1
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date

DATE

o

A
HUNNWUUTI

time

TIME

v
A

R R AR

MR 3.69 A1519HIVOAINAINTTU (tb_title)

o a I 9 v 9 a 9 | EaRl o dy
MoT11e : Hlumsndeyarnidenminssnlszneudleilannieg Al
FIELD NAME | DATA TYPE | SIZE DESCRIPTION KEY | TABLE
title id INT 11| sfaideninnonssy PK
title_name VARCHAR 150 | ¥®
15197 3.70 M3190INNANT TN (tb_photo)
o a I 9 a 9 a g [ dy
o511 : 1Humyndeyaniminssulszneualeiadaiae aall
FIELD NAME | DATA TYPE | SIZE DESCRIPTION KEY | TABLE
photo_id INT 5 SHANINAINT T PK
photo_name VARCHAR 30| A INNINITY
photo_detail TEXT GRGEEIREPRIRY]
title_id INT i1 | sieiademnnanssu FK th_title

ms1ai 3.71 M50 lunszauEIu (b question)

° a I 9 o 9 A EaRl dy
AIDIUY : L‘]Ju@ﬁlﬁ']\iallﬂlluaﬂ']ﬂ'uﬂuﬂﬁgﬂ'lulﬁ?u']ﬂﬁgﬂ@llﬂ'Jﬂwaﬂgn\ic] JU

(%

FIELD NAME | DATA TYPE | SIZE DESCRIPTION KEY TABLE
ques_id INT 11 AN PK
ques._title VARCHAR | 100 |¥1¥evesdiow
ques_detail TEXT 510AZ1DAVDIAID Y
ques_name VARCHAR 30 ¥o l?j: gﬂ A0
ques_email VARCHAR 30 diaal vj’a gt
ques_date DATE Suidoud Auin
Mo
ques_time TIME naimuiindon
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ques._ip VARCHAR 20 | lofidnm
count_click INT 5 fusnudeumany
ques_reply INT 5 fuswudaoudniy

M319N 3.72 M3 emaeulunszaueIu (tb_answer)

oA I { < °
mosue : Humsen g lumsinudeyamaonlunszauemun dsznenaie

a d @ dy
Waan1ee Agil

FIELD NAME | DATA TYPE | SIZE DESCRIPTION KEY TABLE
ans_id INT 11 EA R (RG] PK
ans_detail TEXT 5188210 IAVDIAIND L
ans_name VARCHAR 30 élﬂ'f’r) l%j.}@l’e)“]J
ans_email VARCHAR 30 %maé’é’mau
ans_date DATE fuimuiindiao
ans_time TIME naufindael
ans_ip VARCHAR 20 .| lofidnou
ques_id INT 11 SHAAIDN FK tb_question
M 3.73 M319800 (ampr)
Mot : iHuasndeyadiineldsznoudioiladaie il
FIELD NAME | DATA TYPE | SIZE DESCRIPTION | KEY TABLE
ampr_code VARCHAR 4 D UND PK
ampr_name VARCHAR 30 G?f GRRIGE!
prov_code CHAR 2 THANINIA FK province
M 3.74 msesania (province)
Mot : iflumsndeyadtaninlszneudlsilanain il
FIELD NAME | DATA TYPE | SIZE DESCRIPTION KEY TABLE
prov_code CHAR 2 TN IR PK
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prov_name

VARCHAR

25

d‘ U QJ
FDIINIA

a v Ao o o .
M3N 3.75 ansdunilaiuming (time)

o a I 9 v A o ] 9 a g o dy
Meos11e : 1Wumsveyatunilasvainsilszneualeianniee aail
FIELD NAME | DATA TYPE | SIZE DESCRIPTION KEY TABLE
t id INT 11 | ¥ PK
t date s VARCHAR 30 | JunGusUang
t date f VARCHAR 300 | AuntuganIsuaNas
- Y 9 A :
AN 3.76 M3 11 UIN (admin)
o A 3 E) v Y A Y a S o &
MO8 : (Humsveyamininnisznoualgiladaies Al
FIELD NAME DATA TYPE | SIZE DESCRIPTION KEY TABLE
ad_id INT 11| sfamiii PK
A )
ad_username VARCHAR 20 §ifQ) l%jflclf
ad_password VARCHAR 20 SHANI
ad name VARCHAR 30 FOIIHTIN
ad_surname VARCHAR 30 [ wwanadmin
ad_birthD VARCHAR 4 uina
ad_birthM VARCHAR 20 | euina
ad_birthY VARCHAR 4 | e
M319f 3.77 MINFUINT (executive)
o A & v Y a Y a2 o &
MoT11e : 1umIveyauIMsszneualslannies aeil
FIELD NAME | DATA TYPE | SIZE DESCRIPTION KEY TABLE
ex_id INT 11| sWadusns PK
€x_username VARCHAR 20 ¥o :fl‘]sfj
ex_password VARCHAR 20 THANY
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€x_name VARCHAR 30 %0 Wil‘ua 113
ex_surname VARCHAR | 30 | wwanaduinis
ex_birthD VARCHAR 4 fufiina
ex_birthM VARCHAR 20 | iFeuiiia
ex_birthY VARCHAR 4 | e
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3.5.2

amnsonaaslnsaas 1919 (Interface Structure Diagram) TU@IUNIOONMULINY

Tns9a3arivnae

< 4 o o o o 4
wou 0 ledgudinmsihuobgldaslugdvewmunindulld (Tree) uaasldaganini 3.30
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$120813M3 Include l4la config.php Z;'f g insert_member.php

mstiiadoya

U | o Q'J Q' 9 a
feglsmdImsindeyaaingn

<?

. J Y
include (‘config.php); /M3 Include W@t

include ('function.php'); /N7 Include Tt

$query="INSERT INTO ‘'member’ ('m_id" , ‘'m_username’ , ‘'m_password’, ‘'m_title",
‘'m_name’ , ‘'m_surname’ , m_nickname’, ‘'m_gender' , ‘'m_age’ , ‘'m_birthD", ‘'m_birthM" ,
‘'m_birthY" , 'm_address’ , 'AMPR CODE" , 'm zipcode' , ‘'m_phonehome’ ,
‘m_phonemobile’ , ‘'m_email" , ‘m school’ , 'm_el id*, 'm_interest" )

VALUES (", '$m_username','$m_password', '$m _title', '$m name', '$m_surname',
'$m_nickname', '$Sm_gender', '$m_age', '$m_birthD', '$m_birthM', '$m_birthY", '$m_address',
'$ampr_code', '$m_zipcode', '$Sm_phonehome', '$m_phonemobile', '$m_email', '$m_school’,
'$m_el id', '$m_interest');";

$result=mysql _query($query);

7>

<script languagez"javascript">alert("Lﬁ3J b ’rm“ai% g5 00Id I");</script>

<? echo "<meta http-equiv=\"refresh\" content=\"0;url=index.php\">"; 7>

mesinelaalilsunsa : Wumsiindoyalua1s1e member
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<?

$host="localhost"; //5?;'6 %30 IP database server
Suser=""; //5?;'6 user

$pass=""; /ISAEHIU
$dbname="website"; //%’?Jﬁ 11!5191}@3;!,@1

$con=mysql_connect($host,$user,$passwd)or die("CAN NOT CONNECT SERVER");
a 1 9
// mﬂmgmmay‘a
mysql select db($dbname,$con) or die(""hjﬁg1m9|’ay‘a“1uizuw);
7>

o a3 A 1
aresnelaalisunsy : Hlumsandogiudeyalunii config.php
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<?

include (‘config.php');  //N13 Include &

$sql="select * from member
where ( m_name LIKE '"%$keyword%' ) //ﬁ1ﬁsl°lafjclum'ﬁﬁ}uﬂ1
or ( m_surname LIKE '%$keyword%' )
or ( m_nickname LIKE '%S$keyword%')";

7>

o I
ameselaalilsunsy : iHumsdumndoyaluaisns member
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<?

. J Y
include (‘config.php); /M3 Include W@t

include (‘function.php"); /N3 Include T &idhan

$sql="UPDATE "member' SET 'm_username’ ='$m_username',

‘'m_password' ='$Sm_password', ‘'m _title' ='$m _title', 'm_name’ ='$m_name',
‘'m_surname’ ='$m_surname', ‘'m_nickname’ ='$m_nickname',

‘m_gender' ='$m_gender',)m_age’ ='$m_age', 'm_birthD" ='$m_birthD’,

‘m_birthM" ='$m_birthM', 'm birthY" ='$m_birthY", 'm_address’ ='$m_address',
‘ampr_code’ = 'Sampr_code', ‘'m_zipcode’ ='$m_zipcode',

‘m_phonehome" ='$m_phonehome', ‘m_phonemobile’ ='$Sm_phonemobile', ‘'m_email’
='$m_email', 'm_school' ='$m_school', 'm_el id' ='$Sm el id', 'm_interest’ =
'$m_interest' WHERE "'m_id" ='$Sm_id"";

$result=mysql query($query);

7>

mesinalaalilsunsa : (Humsud lydoyalunisre member
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<?

. ¢ v
include ('config.php"); /D17 Include Tl
$sql="delete from member where m_id ='$m_id; ";

$result=mysql _query($sql);

7>

o <
mesnalnalisunsy : Wunsaudeyalumisa member
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http://www.argosoft.com/mailserver/download.aspx



Lot

SOFTWARE DESION

£ Hews
& Mail Server & PP Server
T, mail Transter LS
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Au'le http:/www.argosoft.com THiaanaena11i Inaailu ArGoSoft Mail
Server(Freeware)

@ o 9 a—I 3 A o a &
2. ﬂﬁ\‘]ﬂﬁﬂTJUIﬁaﬂiﬁﬂﬁﬂﬂM Agsmail.exe INONINITAAGIN

&

agsmail,exe

v 9
MNN 0.2 waasi2 150nTuaana

1 v
3. AANTJu Setup 1HDINTAAAT

WinZip Self-Extractor - agsmail.exe
‘% ArGoSoft Mail Server Freeware w1 .8.6.0

Cancel
About
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Design\Mail Server\ 13114 ¢:\Mail Server\ ga‘%mgé”mﬁﬂﬁu Next >

Settings

Install

ArGoSoft Mail Server Freeware Installer

Program Directan: |C:\Mai| Server',

[w Create Shortcut on Deskiop

[w Create Shortcut on Start M enu

v H 9
M 0.4 naasnth Ididennegnisanad T sunsy

¥ 1 9
5. ﬂaﬂﬂll Start Installation Lﬁmmﬁwmimm

Settings |

Inztall

ArGoSoft Mail Server Freeware Installer

Start [nztallation

< Back
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Q

U OK 11ag Finish

ArGoSoft Mail Server Freeware Installer [x]
Seftings || Instal
| Start Installation |

Copring image ;
Copying imagelUiu el

i ) Installation has been completed

Creating shart

Creating short

Adding items to programs menu

< Back

' £
a o t4
ﬂ"l‘Wﬁ 1.6 LAAININNITAAAITNIYTU

7. 9103 Start Wi on 19311 AAN Start > AN ArGoSoft Mail Server 139

P '
auiianani loneu ArGoSoft Mail Server 111 Desktop

WinZip

ArzoSaft Mai

Programs
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Settings
Search

| Help and Support
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©
=
£
(5]
o
£
o
e
o
[«
E3
w
=
o
o
£

@) Turn OFF Computer...

dltw.jpg

a A A 9
MNN 0.7 Llﬁﬂ\?ﬂWWﬂ'ﬁlﬂJliﬂﬂiﬂ)’\ﬂu

-5



8. Aaniju OK

data in the Options dislog box

@ Relay will be turned aff, To allow it, please specify sufficient

NNA 1.8 LEAY message box
w \J . \ v =Y
1.2 M35U5uuA3 ArGoSoft Mail Server faUM3IIF NI

1. auanani llf]ﬂﬂu ArGoSoft Mail Server U Taskbar

MNA 0.9 1aAAY19ABU ArGoSoft Mail Server

2. AANUY File > Stop (Ctrl + P)

3. AANIUY Tools > Options INBINNT10AZIDHA 1AL

“& ArGoSoft Mail Server,

&=H Tools

b view Log File  Chri+L

6/8 View Previous Logs Serw
B8 Serv
EELl & Cpkions las el =r S
EFE -pHon= Sl r sta
Mes m Users Chrl+u

Wi )

Hio V2 Dynamic DNS

Daz

Svs Ackives Library 2

Hax

Local host: lanogsad

Local addresses: 159z 162 10.2
Local host after reverse look

MWA N.10 LAAINITIADN Options
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~ A1 A N~ 1 Y a ~ A o
N DNS Server : ﬂiﬂl@]ﬂ@umﬂ‘imﬁﬂqclﬁﬂﬁﬂﬂ INTONHNIY / TEUVITNING

dudu DNs vesguiiimamlalisaludansaii lilddedinllaflumineay ip address

4 H g 3 1
IATDIAUBI N Local Host : a1 unsalizonldanuudriiudy (Webmail) luniildams <

¥q 1 & . A Afqva g 2 v &
1p address
I laflununeay ip address 1A399aW09 Ut o nurawariunaninly

= 19 Yas A g I
ﬂiﬂl]’lﬂtlslf?ﬁﬁﬂﬂluaw"lunﬂ

(®11118 18 1% Outlook)

[] Load Server at Windows Startup
Automaticallty Start the Server
[] Allow Relay

[]Hide Passwards In Logs

Local Host: \ \

Do Mot Uzeweb Interface
Allovy Creation of Accountz from 'web

When Bouncing, Include Original Meszage

Logging SMTP Authentication
General

I Ok H Cancel H

Help

Local Domainz AL _Eu_;uris el
DMS Server: 203.145.8555'_'_'_} !

~ A Y <3
ﬂimwﬂﬂhmunu
Options [5__(|
Logaing SKMTP Authentication
General Local Domains Ports
| DNS Server: |203.146.86.65 |

[[JLoad Server at Windows Startup
Automatizallty Start the Server
[] &llowe Belay

[]Hide Pazswards In Logs

Local Host 19216810253

[7] Do Mot 1 ze wWeb Interface
Allow Creation of Accounts from ‘web

When Bouncing, Include Orniginal Message

ok || Concel || He

MNA A.11 uaaImIUSULAL General

laﬂﬂ!!‘ﬁ‘u Local Domain

v Y
A o

a o4 Ay 2 ) & g .
WNW‘H@Tﬂmu‘ﬂ@mﬂﬂﬁ“Vlﬂﬁ’t]’ﬂﬁnﬂiﬂﬁWHNGIENﬂﬁiu‘ﬂuﬂﬂ!ﬂu siamcom.co.th

3 a
sudInanu Add




Options

General Local Domainz Ports

siamcom. co.th

1
|siamc:0m.c:0.th ||

Fieplace I Add l[ Delete ]

ok |[ cancel |[ Hep |

MNA .12 LaaIN1sUTuLAY Local Domain
= ]
1aanUNY Ports

weraanInea port 1193 on 99 (il 1imioway hidealfuudaes 1s)
- SMTP (Simple Mail Transfer Protocol) T¥dmSudand < port 25
_ POP3 (Post Office Protocol) 14111n15A91318910 mailbox 118711 < port 110
- Finger @329 a0 Us 100210007 19 < port 79

4
- Web Interface 380151 U0afUNIANTNYI 11303 < port 80

| Llosgng | SMTPAuthentication
| General | LocalDomans | Forte
Web Interface
[ ok ][ cencel |[ Hen |

MNA 1.13 uaaImsUSuLag Ports
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1aanUNY Logging

3 J J < ] a o
1Hlumsinuaen Tidms Inumaves user nsaidosmanu lianawnsondnidonsa

51l i lideamaiives 15 lisuiludesnaniden

Options [z|
General Lacal Damaing Parts
Logaing | SMTP Authentication
Log SMTP Commands
Log POP Commands

[ Log SMTF Converzations with Egchangers

Log Web Commands
Log ta File
|
L Ok 1 [ Cancel I l Help

MNA 0.14 1LEAINTUTULAS Logging
Lﬁanuﬁu SMTP Authentication

9 1 4 a S < a
1¥lunsaidesmsaauanonlandumes ingiis AuAaoINT1U SMTP Server UD4

J a

v 9 1 1
guavsmsaeTuniids lideatlaldsumantly oK iivetiuiinmsasunlas

Options @
General Local Domains Ports
% SMTP Authentication
[ Enable SMTF Authentication
ak, ] l Cancel ] l Help

MNUAN 0.15 1aAINTUTULAS SMTP Authentication
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Information le

\:!‘) You have modified message size limit information,

The change will nat kake effect unkil you exit the
server, and skart it again.,

MWl n.16 AanTJy OK veiiuinmslasunilaq

1.3 P3N Mail Account 191521

o o 1 3 A < 2 4 ) [
Wa\ﬁ]']ﬂlliﬂllﬁ\uﬁﬁFﬂlﬁﬂﬂ%@ﬂllgjﬂﬁ\jﬂﬁ']’)lwui’m%@ user A1NITUNATDUIEVY

1. ﬂaﬂﬁmu Tools > Users (Ctrl+U)

“& ArGoSoft Mail Server
File REsElEs Help

b T ViewlagFile  Crrl+L F
Berwver :

ErE Wiew Previous Logs
516 - | Berver :

B8 &3 Options Chrl+oy  [2Y Serwer
(= jr startir

Me = |

Wiry .

Hig V2 Dynarnic DS

Des— — o
Sw=dckived Library L
Max —

Local host: lm{;éd

MNA .17 uaaINsUs VLA user

2. AanNAdd New User

2 = -

Add Mew Llseri

NN N.18 LEAAINTINY user
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3. WUW518821989 account user User Name : %0 login ,Real Name : %a—umﬁqa

a o 1 o o 1 d
A9, Password : TUANIY, Confirm Password : gudUTHarILWa , %94 Forward Address NI

o 2A 1
A0aM3 forward ldaundou (lidesszyy)

Add New User,

General | Finger Information |

3

Pazswiord:

Uzer Mame:

Real Mame:

Canfirm Pazzword: |""""

| arnut

|.-’-‘«.Amut Futtanatirakul

|xm

Fonward Address:

pAoipieg

Returm Address

|
|
L L Lot

|
|
|
|
]
]

aK ][ -Féncel ][ - Hep |

Y a 4
ﬂ'l‘Wﬁ .19 HEAAINITNUNI18aZIDYA

4. 1WH Account mail N@eIMsldmadeU Lagnanilu Close

o a3 d A 4 a ' . .
asaiidy ledasaannsa leyeaSanaaon 1195 webmaster, admin, info, sale

User Setup

i
i

admin

i
i

zale

jo

info

L

apirak,

x]

L

webmaster

Cloge

MWA 1.20 LAAINTINY Account mail NADINI lFNATOU
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5. aantlu Start 1o uTlalFau

“& ArGoSoft Mail Server
File Tools Help

SIEY

gEfESZ004 1E5-F4:359 - BN
&fES2004 1E5-EFE4:40 - POI
/62004 15:24:40 - Fir
RARSFNNA TE-F4-4N - H¥

MnA .21 naaamsalalaan
. Y

Tip.M3FH

1 a 1 o @ [ 4
1571 15991 Mail ansaldau laesavse i Tae l9@da telnet 1369 port vouud

a 4

Start > Run... WUN
telnet 127.0.0.1 25< NAd0L SMTP

telnet 127.0.0.1 110 <@gy POP3

- Type the name of 3 program, folder, document, or
Internet resource, and YWindows will open it for wou,

Cper: | telnet 1z7.00.0 25 i v

| Ok ;][ Cancel ][ Browse, ., ]

MNN 1.22 NATOU SMTP

% Telnet 127.0.0.1

220 ArGoSoft Mail Serwver Freeware. Uersion 1.8 <1._.8_.6_.@>»

NN 0.23 test port 25

& Telnet 127.0.0.1

+0K ArGoSoft Mail Server Freeware. Uersion 1.8 (1.8.6.6>

MNN N.24 NATOU POP3 test port 110



n-13

1.4 M3538n1%914 ArGoSoft Mail
1. luntinageuionlFaurumeniidu lae
Taemsi 1 URL 131 hitp://127.0.0.1/ < 3on1ag]d localhost 30 http://192.168.10.1/ <

Fonlagly ip address

2 ArGoSoft Mail Server - Microsoft Internet Explorer,

i File Edit Wiew Favortes Tools  Help

i dddress E@ http:ff127.0,0,1f

Date 6/6,/2004 Time 16:33:00

A {ive Star Trperience
fmz,w&;aé,@f Now,

Welcome to ArGoSoft Mail Server

You can check your mail from here

MW 0.25 Uaaani s nuams 1991

a . A 9
2. ﬂﬁﬂﬂjJ Login (ND15EUU

A oA A YA g ' v &
3. WUNHD User/password miw"lmwmﬂniz‘wﬂauﬁmu

Connect to, 127.0.0.1

(59

i)

ArGoSoft Mail Server

Liser nare: | € amut w |

Password: | T |

[C1Remember my password

ok [ Cancel

MNA 0.26 Laaaniinseu username 1az password
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4. HARINI99 ArGoSoft Webmail

User arnut

You have 0 messages waiting.

% Compose X Delete  Check Mail % Settings ] Log Out

[l From | Subject L oate | size |

_ GETFREE STUFF.,

ArGoSoft Mail Server Freeware, Yersion 1.8 {1.8.6.0%

WA 1.27 !Lﬁﬂ\iﬁfﬁll‘iﬂﬂlﬂﬂ user

Jd o v d
lmuﬂaiuﬁmiumma

it Send % Attach Msg List  [] Log Out

If wou wish to send the mail to multiple recipients, separate names and addresses by commas.

Marme of Sender: @n@tf_@ﬂ-a_n_at\rakl:I
Email of Sender: I_Eeé@s?&mgom.co.tl:l
Mame(s) of Recipient(s): _;__ 4 :I
Ernail{s} of Recipient{s): } iyl :l
Mame(s) of CC Recipient{s): r :I

Ernail{s} of CC Recipient{s):

Email{s) of BCC Recipientis): | |

Subject: |testmai\ja |
Message Body: VIEFDURSIA 1
Attachments:

- s ' s
HNNN N.28 Llﬁﬂﬂllﬂﬂw@‘iﬂﬂ'ﬁﬁﬂmﬁ
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2. 35msfnnallsunsa appserv-win32-2.5.1

Y
1. lauruTysunsy Appserv-win32-2.5.1 aalud@asen lasfluruszriaudanalae

00 LU AIAINN N.29

Welcome
Welcame bo the AppSery vi2.5.1 Setup pragram, This progeam wall nstall
AppSesy w2 5.1 on your compulter.

I iz stiorgly recommendad that pou 26t 2l Windows pograms befone
running ths S etup progranm.

Chck Cancel bo quit Setup and then closa any programs pou have running.
install Chick Hest to conlinue with the Setup progranm.

WARNIMG: This-pogam is pratected by copyright [w and intemational
heaties.

Unauithouized reproduiction or dizinbution of this program, or ary porion of &,
may ezl n sevess civiland ciminal penalies. and wil be proseculed 1o
the: maximum extent possible under law,

§COMPUTE® -

v v Y
MNA 7.29 LAAUTUNITAAAT Appserv-win32-2.5.1

a = ~ =y ) a g’/ a A 3 9 a
2. ﬂﬁﬂlﬁf)ﬂ]’lmiﬂﬂ@i NITNINITANCN ﬂﬂ@%agw C:\AppServ LE@TAULAINAN

Next A9 INA 1.30

Choose Destination Location

Setup will inglall AppSery v2.5.1 in the following diechon.
To instal to this divectony, cick Mext.
To mstal to a different disechony. ciick Browse and select another direchon.

*fou can chooss not bo install AppSery w251, by ciicking Cancel bo exit
install Setup.

for you.

Space Requited: 35124 K.
Space Avalable: 9348229 K,

< Back Heat » Cancel

~ A =
HNN N.30 Llﬁﬂ\iﬂ'ﬁmﬂﬂllﬂﬁﬂﬂi‘)ﬁ
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A a g’z a I . 3 9 a [ ~
3. LaﬂﬂgﬂllﬂﬂﬂTiﬂﬂﬁ\‘] SIEREY Typical LF#3AINAN Next AININN N.31

Setup Type

Chck the type of Sebup pou prefer, then chick Nest

* Typacal Program will be installed with the most common
options. Recommended for most users.

" Compact Program will be instaled with mramum requined
oplions.
Oriby Apache Web Serves

“fou can chooss the options pou want 1o instal
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